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This document describes all items in the Application Menu of the QGrip-UL.

Introduction

Application | Jobs Trace Reports

Oe Pip % O

Contacts
Organisation-Unit-Application

Link2App
LabelClients
DatabaseAlias

PostClone Scripts
AppObjects

Connect Info

Password Safe




2 Contacts

Required Authorisation

Edit Organisation/Unit/Application

Application -> Contacts

Recommended documentation

Doc-Tab Title

Application

Section

Contacts & Suppliers

Contacts and/or Suppliers can also be edited from the Application edit window.

Edit Contacts:
' ﬁ Contacts _
I~ Suppdir I ;I Remark | Applications
»
Rote |App Suppors =] _i_Fushr
Rame |S:zve Camay B
Etmail [Stave Camey@Griponsqgtom
Phone [os- 123455785

| Bervice Coordinator | Piater Pietersan

| Email
o Carmnpy Steve Camey@Grponsqlorg | 06-123456789
| Maikeppisior ol

| Mo phona
| |Ser'-'ice Coordinahliﬂan Hur il;ar_].hu@gﬂpcn!ql.rg |
| | App Supports | Test i_i’ist_ 'l'_Fest
| | App Supports | Jay Jansen | Jay@messy-solutions com | 123456 788

Maindatory & Unique: Name

New:
Edit:
Save:

Press New to enter edit mode to add a new Contact.
Press Edit to enter edit mode to modify the current Contact.
Press Save to save changes to current Contact. The edit mode will be existed.

Cancel: Press Cancel to exit edit mode without saving changes.
Delete: Select rows in the Contacts tab and press Delete to delete contacts.
Link2App: Press Link2App to open ‘Link Contacts to Application” window, see below.

New
Rename
Delete

Right Click on Supplier/Role Drop-Down to Add, Rename or Delete occurrence. When deleted, the

Supplsr | [Messy Soluons - |If
Rola |AppSa.rp|:||:|rl ﬂ

Name
Emad
Phane  [123 456 789

[y Jan=en

| ayEimessy-solutions.com

occurrence will be deleted everywhere where it is being used.




Link Contacts to Application: Unlink

a Link Contacts to Applications

Applications i Contacis Close

Appiication Contacti | Contace Contact | Role | Supplier *
4 Ben Hur | Service Caﬁrd'ujalnr
[j.i_an_Jemberg App Supports _Glip on SQL

-Jay Jansen IA_ppSuppom
Pieter Pigtersen iSENir.e Coordinator

RobinHood | App Supports Grip on SQL -
- Link Contact | |~ Cantact Edit
<<Links<< | New. | Edt. | Deete |

To Unlink (clear) the contacts of Applications, select the application rows and use the buttons:

Contactl: Clears Contactl
Contact2: Clears Contact2
Both: Clears Contactl and Contact2

Link Contacts to Application: Link

ﬂ Link Contacts to Applications = O >
Applications ] Conlacts Close
| Application Contact | Rote Supplier |
Ben Hur Service Coordinator |
Dan Jemberg | App Supparts |Grip on SOL
Jay Jansen App Supports | =

0001-masteiDB [ Piat Sarvice Coordinatar
18 |RobinHood | App Supparts
Link Contact — [~Contact Edit

Contact! | Contactz |  Both ]‘ ‘ New | Edt. | Deete |

To Link (add contact) to one or more applications, select the Application rows and the Contact row
and press <<Link<<. Contact1 and/or Contact2 must be empty, otherwise the action will fail.

|Grip on SOL

Link Contacts to Application: Edit Contact

) Link Cantacts to Applications o O #
Applications ] Contacts | Close |
Application |contacti | Contacz | U=~ | contaet | Role | Supplier =
Messy Steve Camey : ) _Ss_ Ben Hur | Service Coordinator I
Pushy |Jay Jansen Sz Dan Jemberg | App Suppons Grip on SQL
Vasta- Vs Jay Jansen ! S Jay Jansen !App Supports | aun
0001-masterDB | | T v ns
| | 4 |GriponsaL| =+
~LUnlink Contacts ~Link Contact — ~ Contact Edit )\_
Cotact] | Contactz |  Both | ‘ <<link<e | h Mew. | Edt. | Delets |

To quickly edit, delete or add new contact, use the Contact Edit buttons. Edit and Delete acts on the
selected Contact row.



3 Organisation-Unit-Application

Required Authorisation
Edit Organisation/Unit/Application | Application -> Organisation-Unit-Application

Recommended documentation
Doc-Tab Title \ Section
Basics Substitution & Naming conventions
Application | Contacts & Suppliers
Application | Organisation-Unit-Application
Application | Default DB Host & Environments

In the Organisations window, you can add new Organisations, Units and Applications to QGrip or
edit/delete existing ones.

3.1 Organisation

|. Grip on 5GL

Organisation I

Orgamisation  |Grip on SQL BV Cost-ID |1.0.0000
DisplayName  |Grip on SOL

When adding or editing an Organisation you need to enter:
Organisation (*) | The name of the Organisation.
DisplayName (*) | The name shown in QGrip, preferably same as Organisation.
Cost-ID Identification to be used in Charges, Split Costs.

(*) Unique

Deleting an Organisation with underlaying Units is not possible.

3.2 Unit
| p Sales |
Unit |
Organisation  |Grip on SQL v | CostiD [1.2.0000
UnitName  |Sales
DisplayName |Sales

When adding or editing a Unit you need to enter:
Field Description
Organisation Owning Organisation.




Unit Name (*) The name of the Unit.

DisplayName (*) | The name shown in QGrip, preferably same as Unit Name.

Cost-ID Identification to be used in Charges, Split Costs.

(*) Unique

Deleting a Unit owning Applications is not possible.

3.3 Application

ﬁ Pushy

AppEcaticn'

Unit [Sales <] CostiD  [122002 . Ne“'m
AppName  [Pushy-App CMDB-ID_[212002 #7 | Delete
AppKey [Pa Supplier <11

DisplayName [Pushy

[ IsService [ Is Cluster Aware Cantact | E|

contect [
bl = L Edit
Delete

When adding or editing an application you need to enter:

Field Description

Unit

Owning Unit.

App Name (*) (***)

The technical name of the Application.

App Key (*) (***)

The Key Identifier used for the Application.

DisplayName (*)

The name shown in QGrip, preferably a combination of AppName
and AppKey.

IsService

Check IsService if the application is a service.

IsClusterAware

Check IsClusterAware if application is Failover proof in a SQL
AlwaysOn environment.

Cost-ID (**) Identification to be used in Charges, Split Costs.
CMDB-ID (**) The identifier used for application in organisation CMDB.
Supplier If applicable select, right-click to Add/Rename/Delete.
Contact (1&2) If applicable select, right-click to Add/Edit/Delete.

(*) Unique

(**) By default, filled with AppKey.
(***) AppName + AppKey should be without spaces and special characters.
This will be checked and cause error message.

Inputfields not correct

Illegal characters in AppName Illegal characters in AppKey
[ 1Pos=7 [ 1Pas=2

Inputfields not correct

[ox ] [ox ]

Deleting an Application linked to (Infra) objects is not possible.

3.4 Default DB Host and Environments




Default DB Hosts are necessary when you want to create new Databases and/or Logins (App Objects)
for an application. Initially you do not need to enter them. During the Link2App process the default
DB Hosts and environments will be automatically added whenever possible.

Default DB Host
1. Instance (Stand Alone)
2. Listener  (Always on Cluster)

When defining Default DB Hosts, you can do it on all levels:
1. Organisation

2. Unit
3. Application

The Default DB Hosts can be inherited from the owning entity.

Save first

On all levels you need Save a new entity before you can check the ‘Default DB Host’ check box and

you need to save afterwards as well.

Set by Right-Click

Right-Click in the Default DB Host panel will open a menu with possible options:

[¥ Environments and Default DB Hosts

| Environment | Domain | Type | Mame Inherited | From
k AL Hentanas | YMSQLT201\PRD
=] Add Test vl
Del |  Acceptance »|  <Inherit>
Production k AD

VMSQL1201\ACC

Organisation Level

At Organisation Level it is only possible to select an existing DB Host.

[ Default DB Hosts

Environment | Domain
3 AD

Type

| Name

Instance |VMSQLI201\PRD

Unit Level

At Unit Level you can either select an existing DB Host or Inherit. If you choose Inherit, the DB Host

will be inherited from the owning Organisation. If you add an Inherited DB Host but it is not yet
defined or has been removed at the parent level, the DB Host will remain empty until added at

parent level.

[ Default DB Hosts

Environment

Production

|Domain  Type | Name Inherited | From
| =
|AD |Listener |AG_LIST.O1, T




Acceptance is Inherited and not yet defined at Organisation level.

Application Level
At Application Level you can either select an existing DB Host or Inherit. If you choose Inherit, the DB
Host will be inherited from the owning Unit. If not set at Unit level the owning Organisation will

apply. If you add an Inherited DB Host, but it is not yet defined or has been removed at the parent
level, the DB Host will remain empty until added.

T
[¥ Environments and Default DB Hosts

Environment | Domain | Type | Name | Inharited | From
Ol | w

|Accoptance  |AD Instance |VMSQLI20WACC W |Unit

'Producion | AD Listener (AGLST.O1 | I

At application level the Default Instances is in combination with environments. When you add a new

application to QGrip, this is where you will specify which Environments (DTAP) the application will
have.

Note

Using Inherited Default Instances is a possibility but completely optional and should only be used if
your organisation/architecture is suited for it.
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4 Link2App

Required Authorisation
Link Objects to Application Application -> Link2App

After the Discover of an Instance, all newly found objects need to be linked to an application, that is
considered to be the owner of the object. An object can only have one owner.

Be careful when linking the objects. When an object is linked to the wrong Application, it might be
accessed and changed and in the worst case dropped by the wrong team. This also influences the
Charges (Split Costs).

Unit [IT-Service ~|
AppName | cleanup

AppKey [_cleanup

DisplayName |_cleanup

v Is Service| [ Is Cluster Aware

When you first start using QGrip, you will probably be confronted with objects of which the owner
and status is unknown. A possible temporary solution is creating a fake Application and link the
unclear objects to that Application and sort them out later. Make sure to define the Application as ‘Is
Service’ to avoid confusion as the objects will probably be spread out over several Instances.

€) Link to Application — ] X

IEI

STSQLIS\ACC
Databases

1] PSH_A_Core
| PSH_A_PIET
| PSH_A_Staging

Logns
& SQL_PSH_A_Pushy_AppUser
STSQLIS\TST

00
cllt:u:u:l-’_en

m.._.....
20 @-m[j'i“n[:]n @nD
™

ofooo

& SQL_PSH_T_Pushy_AppUser

ok | udlink | Auolik | Cose |

The left Explorer contains the objects that have already been linked to applications and in the right

Explorer all objects that need to be linked. Use the | €2 button in the toolbar to refresh the
Explorers whenever needed. The aim is to keep the right Explorer empty. A warning will be issued
when there are Unlinked objects.

11



4.1 Link Objects
€) Link to Application

l.hwadl
_ E BTSTSQL19\ACC
Databases
PSH_A_Core
PSH_A_PIET
PSH_A_Staging
Logs

288 -
-

e

m.................. S—
o0 o©

o
a0 s&&80]

L_PSH_T_Pushy_AppUser

| -‘1:15 SQL_PSH_P_Pushy_AppUser

Check the objects you want to link to an application in the right Explorer and check the application in
the left Explorer and press Link. The objects will be moved to the application in the left Explorer and
disappear in the right. Object with grey ‘disabled’ icons cannot be checked.

L_PSH_T_Pushy_App
ﬂ PSH_T_Core

| PSH_T_Staging

If an unlinked Login is DatabaseUser in one or more databases, the databases will be shown under
the Login. This might help you to determine the correct Application to link to.

4.2 Unlink Objects

12



€) Link to Application - (m} X
4+ S B X

% I UnLinked |
&[] Grip on SQL TST
@-J¢p IT-0BA
&- 14 Sales
@1l MSY-Messy
@[] OPSY-OldPushy
&~ PSH-Pushy
@-[]' " Databases
& [Jgenlogins
@ |Zhe SQL_PSH_A_Pushy_AppUser
# SQL_PSH_P_Pushy_AppUser
] SQL_PSH_T_Pushy_AppUser

tnk | [Tuniink ]| Autolink |  Close |

Check the objects you want to unlink in the left Explorer and press Unlink. The objects will be mbved
to the right Explorer and disappear in the left. Object with grey ‘disabled’ icons cannot be checked.

4.3 Autolink Objects

Defining AutolLink rules is great way of minimizing the effort and time spent on Linking objects to an
application. How often you can apply it, depends on how standard the names of the objects are in
your Organisation. Changes to AutoLink Rules only apply to future AutoLink actions and will never
affect already linked object.

Before Save and Delete, confirmation is needed.

4.3.1 Adding AutoLinkRule(s)

In this example the names of the databases and logins all contain the AppKey 3333.

ide S H X 2| Wl 2SS 1@
Linkgdl LfnLinkedl
&[] 2001-Portia ~

e DD 2002-MoneyMoney |
- |:| HumanResource —

l as TeslApp3333XA

|:| Logins
(- SQLLogin_3333_A_TestApp_Appllser I
BT i SULLogin_ 3333 A_TestApp oA

I Databases -1 SQllogin_3333_A_TestApp_User
512 SCllogin 3333 T TestApp Application
- [1E, VMSQL2014PRD

m

DD 5000-FirstChoise
D Sales

[<

ok | Uniink || Aulolink | Close |

Check the application (3333-TestApp) and one of the databases and one of the logins and press
Autolink. The AutolLink window will open:

13



ObjectType |AgentJob
ObjectName | T

SelectedByYou | AutolinkRules
ObjectType ObjectName Application

Login SQLLogin_3333_A_TestApp_AppUser|3333-TestApp

In the Tab SelectedByYou the database and logins selected are visible for the selected Application
3333-TestApp. The Application, ObjectType and ObjectName in the input section does not yet
contain what we want. By selecting one of the rows in SelectedByYou, the input section will be filled
with the values of that row.

Application 3333 TestApp -] New Application  [3333-TestApp ] New
ObjectType  [Database = Save ObjectType save |
Obij 34 Delete | ObjectMName [%3333% Delete
| Insert Wildcard  » All-Chars ] T
None-Digit Close iz
One-Char
SelectedByYou | AutolinkRules | SelectedByYou |AmolinkRuIes |
ObjectType | ObjectiN: ObjectType \ ObjectName | Application
» Database Tes A TestApp [3 Database TestApp3333A 3333-TestApp
Login SQLLogin_3333_A_TestApp_AppUser | 3333-TestApp Login SQlLLogin_3333_A_TestApp_AppUser [3333-TestApp
| _ L

Adjust the ObjectName either by using Right-Click and select a wild card or enter ‘%’ manually and
click save. The Database row has now disappeared in the Tab SelectedByYou. Do the same for the
row with the Login in the Tab SelectedByYou.

Application {3333 TestApp =] o |
ObjectType IDatabase | e |
ObjectName [%3333% — |
Close

SelecldeyYD‘ AutolinkRules I

ObjectType ObjectName /| Application -
» Database 3

2

The new Autolink rules have been added in the Tab AutolinkRules. All databases and logins with
%3333% in their name will automatically be linked to Application 3333-TestApp.

4.3.2 Changing existing AutoLinkRule



;

3 Login
AgentJob

NT SERVICE\%
QGrip-LoginLastActive

0000-QGrip

Application  [0005-NT-SERVICE |
ObjectType ILogm LI
ObjectName [NT SERVICE\%
SelectedByYou AutolinkRules
ObjectType ObjectName /| Application o

NT-SERVICE | Riogpmiem]

-

Save

Delete

Close

Select the row you want to change to fill the input fields. Adjust the input fields and press Save.

4.3.3 Delete AutolinkRule(s)

Application  [3333-TestApp

ObjectType  [Login

SelectedByYou

ObjectName |223333%

AutolinkRules

ObjectType ObjectName

Dat: 3 =7
» Login

/| Application

Select the rows you want to delete and press Delete.

4.3.4 Overlapping AutolinkRule(s)

Application  {0006-SQL-Stuff

ObjectType

Database

Lef L

OhjectName[

|

Consider the AutolinkRule above that would apply to every database. If you try to add a rule that will

overrule existing rules you will get a warning/question:

15



Autolink definition will overrule existing rules:

[%3333%] for application [3333-TestApp]
[%:QGrip%] for application [0000-QGrip]
[master] for application [0001-masterDB]
[model] for application [0002-modelDB]
[msdb] for application [0003-msdbDB]
[tempdb] for application [0004-tempdb]

Would you like to delete these rules?

16



5 Label Clients

Required Authorisation
Label Client Application -> Label Client

F MSY-Messy

DatabaseMias [ AopServers | Logns | DatabaseUsers | Agents
Test ATSTAPP1 | 202404-14 09:19

> | Production ATSTAPP _

The Discover process collects connecting Clients on the Instances.
By labelling these clients as ‘AppServer’ (Application Server) or ‘OtherClient’, a list of AppServer is
produced. Inthe QGrip CMDB, this list can be presented per Application.

Label Clients:
Labelling Clients is straight forward.

' ) Label Clients - 0 x|

ToDo | sopServer | OheCiert | II EstLabes |

In the ToDo tab, select rows, right click, select the Label.
You can do the same in all tabs to correct mistakes.

Add your own labels

Next to the “‘ToDo’ and ‘AppServer’ labels that cannot be changed, you can add up to 8 labels.
Click on the Edit Labels button.

17



When returning to the Label Client Window, a tab Workstation has been added and you can label
Clients as Workstation.

18



6 Database Alias

Required Authorisation
Edit Database Alias (*) Application -> DatabaseAlias

(*) For the Application

Recommended documentation
Doc-Tab Title Section
Basics Database Alias

The Database Alias window consists of 4 parts:

| Q1 Dstabase Alss - 0 x|
T Rkt |
P Mysops [MSY-Measy 1. =) _ Cose |
Ml
| Atolrk  DatabaseA SQLVerson Tet | A  Prod,
o = = £ A [ |MSYACow  MSY_P Coe
M Seong 2019 MSY_A_Sagng  MSY_P_Sagng
I
Unlinked l
L Emwormert | Databose | Instance | Eeomert  Datsbose | instance
» Aoceptance | MSY_ACore | ATSTSGLISVCC » MSY_T Core | ATSTSQUIS\TST
| Sagng w3. MSY_A_Stagng ATSTSQLIACC Text MSY_¥*%agng ATSTSOLINTST
| Core _Mw »IISY_P_CM ‘ATSTn 19PRD
Sagng Production MSY_P_Stagng ATSTSGLIS\PRD

Application Selection.

Existing Database Aliases including overview databases.

Databases linked to a Database Alias.

Databases that need to be linked to a Database Alias. This panel should always be empty.

PonNneE

To add, delete, edit, link or unlink, right-click in the panels (2-4) to open the popup Menu.
All changes have immediate effect and are automatically saved.
In panel 3 and 4 you need to select the rows (not cells) in order to Link/Unlink.

19



6.1 Database Alias: New, Edit, Delete

New

Specify Database Alias (name)

Edit

Change the Database Alias (name)
Delete
Confirm delete

Delete DatabaseAlias : Core
Including existing links to Databases?

no |

Deletes the Database Alias and all databases linked to it will become Unlinked.

6.2 Database Alias: Autolink

20



New Autolink

Database Name [WSY_7._Corel

It is possible to define Autolink rules to the database alias, based on the Database name and using
the normal SQL Server wildcards to match. The Autolink rule will only be applied to databases that
have not yet been linked to a database alias.

When a there are Autolink rules present for a database alias, this will be indicated with a checked
box in the Autolink column.

6.3 Database Alias: Link

Link

Select rows, right-click and choose the appropriate Database Alias.

6.4 Database Alias: Unlink

Unlink

21



MSY_A_Core

ATSTSQLINACC

MSY_A_Stagng | ATSTSQLIS\ACC

MSY_P_Core

ATSTSQL19\PRD

Select rows, right-click and choose Unlink.

MSY_P_Stagng

ATSTSQLIS\PRD

22




7 Post Clone Scripts

Required Authorisation
Edit PostClone Scripts Application -> PostClone Scripts

(*) for the Application

Recommended documentation
Doc-Tab Title Section
Application | Post Clone Scripts

Clone ==

Destination PostClone Scripts

Purpose
Database ‘Destination Ready’ after Clone

The purpose of the PostClone scripts is to adjust a database to fit in the destination environment
after a Clone. Mostly, it includes dropping the Source environment database users and create the

users needed in the Destination environment. Also common is changing content of Parameter and
Configuration tables that is environment dependant.

There are 3 different Script types and they will always run in the same order.

Order Script Type Description

1 General Can only be edited by QGrip-Admin.

It should only contain changes that apply to all databases in all
Environments and for all Applications.

2 Updates Updates of Parameter and Configuration tables, anonymising data or
other adjustments that are not user related.
3 Users Drop the existing users and creating the Destination users.

Updates and Users scripts are created for a specific Application.

Unfortunately, writing PostClone Scripts can be complicated and much depend on how well the
database and its security has been designed. Here are some guidelines.
e Use the script menu to Generate Examples, Templates and PostClone scripts to get an idea.
e The aim is to create PostClone scripts that you can run in all Environments and on all
Database Aliases for the Application.
e Test the scripts against a local database.
e Clone databases to a develop (or) test environment that is not being used. If enough disk
space is available, you should also try to the Clone the production database.
e Be creative!
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7.1 Explorer / Navigate

) PostClone Scripts Admin
+ /2R

In the Explorer, you can see existing Post Clone script, grouped by Application. Only QGrip-Admin
will be able to see and edit the General script.

After a script has been changed, you should test it before use.

7.2  Script New

New PostCloneScript : <New-PostCloneScript>

|l <New-PostCloneScript>
PosiCloneScript |

» [ MyApps |Pushy _JG!BQUIY | astClone 'vl |

+ ScriptName  [My Scripname SciiptType [Users v ]

-

Choose the application

Enter a script name

Choose Script Type: Update or Users
Edit the script here

S

7.3 Script Edit
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Comment Block
Script Header

IF {EnvFull} = Acceptance
I IF {EnvFull} = Production QGrip-Remote-Tmp-Usp-Database-Upgrade
IF {Env} = Acc QGrip-Remote-Tmp-Usp-DBUser-Create (Complete)
IF {Env} = Prd QGrip-Remote-Tmp-Usp-DBUser-Create (SQL-Login)
E{E)=A QGrip-Remote-Tmp-Usp-DBUser-Create (Windows-Group)
) V4 QGrip-Remote-Tmp-Usp-DBUser-Create (Windows-User)
Statement  » £ IF{E} =P

QGrip-Remote-Tmp-Usp-DBUser-Drop

> QGrip-Remote-Tmp-Usp-DBUser-DropAll
QGrip-Remote-Tmp-Usp-Role-AddMember
QGrip-Remote-Tmp-Usp-Role-Create

e RemoteProc » ¢
Substitution

AppKey

AppName QGrip-Remaote-Tmp-Usp-Role-CreateAlter
DatabaseAlias QGrip-Remote-Tmp-Usp-Role-Drop
DBName QGrip-Remote-Tmp-Usp-Role-DropAll

: . Domain QGrip-Remote-Tmp-Usp-Role-DropMember
\
Env
EnvFull
Instance
Listener
Port

When editing the post clone scripts in the QGrip-Ul, a right-click in the script will open a menu to
insert pieces of code or substitutions in the script. It is also possible to generate a Template,
PostClone or Example.

PosiCloneScript | ScriptTest
[~ MyApps IFushy Ll {:aiegmy PostClone -
‘ScriptName ITest PostClone lSﬂ“PIT}'PE i_UsEl:s - il
Insert *
Generate  »

The options you have in the menu depend on the current Script Type.

Inserts will insert a statement at the cursor position in the Script. The statement block will be
inserted with the same amount of space from the beginning of the line.

Generate, will replace the existing script but only after you have accepted the “Overwrite” warning.

7.3.1 Insert -> Statement

Comment Block
Inserts an empty comment block

Script Header
Insert an empty script header that you will need to complete.

IF ( '{EnvFull}' = 'Acceptance'), IF ( '{Env}' ="'Acc'),IF ({E}' ='A")
Insert an if statement with Full, Short or Char Environment indication.
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7.3.2 Insert -> RemoteProc

Inserts an EXEC QGrip-Remote-Tmp procedure call.
7.3.3 Insert -> Substitution

Inserts the Substitution variables (the Finds).

7.3.4 Generate -> Example

Generates an Example that will hopefully give you an idea of how to proceed. It does not use any
application data.

7.3.5 Generate -> Template

Generates a Template based on the selected Application and Template information available at that
moment. A really good starting point, but you need to check the whole script and remove stuff that
is not applicable. In comparison with the PostClone described in the next section, the Template is
much more sustainable, but it might need updating after changes to Databases, Logins and Database
users.

7.3.6 Generate -> PostClone

Generates a PostClone script based on the selected Application and the current situation on the
Instances / Databases. This is quick but it is a snapshot of the current situation. If a database is
moved or users are changed, it will not work as originally intended.

7.4 Script Test

Script test not possible

Nco MyDatabases Defined
0 Close this window and Define MyDatabases at

File -> MyDatabases (Local)

[ox |

Before you can test a post clone script in the QGrip-Ul, MyDatabases need to be added.
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Edit PostCloneScript : DatabaselUsers-DTAP

Datsbaselsers-DTAP
®

PosiCloneScnpl sﬂﬂpﬂ'ﬁﬂ'f_ e M Saie=Niw

Save

|IVMSQL1201\ACC) [Pushy_A]

ot Erviios (TN =] o

SmierClose

The script in the ‘Script’ tab will be executed, even if changes have not yet been saved.
Select the ‘ScriptTest’ tab.

Choose MyDatabase to execute against.

Choose Environment and Database Alias to simulate. QGrip will use these parameters in the
Find/Replace.

Press the ‘TestScript’ button and confirm the action.

6. This is where the output of the script can be found.

PwnNE

v

Confirm TestScript
Bun current PastClone-Users Script against
[VMSQL120IN\ACC] . [Pushy A]

9 Simulating Environment: [Production]

Simulating Databasellias: [Staging]

Changes will be made to Instance/Database.

[ ok ] conce

Script OQutput:
INFC: Dropped DatabaseUser: [SQLLogin 3010 T Zeus Application]
: Dropped DatabaseRole: [RoleFATester]
: Dropped DatabaseRole: [RoleApplication]
INFC: Created DatabaseRole: [RoleFATester]
: DatabaseRole: [ReleFATester] DBPermissions granted: [Execute]
: Rdded [RoleFATester] as member of DatabaseRole [db_datareader]
i Added [RoleFATester] as ber of DatabaseRole [db datawriter]
: Created DatabaseRole: [RoleApplication]
: DatabageRole: [RoleApplication] DBPermissions granted: [Select,Ingert,Delete,Update,Execute,References,Alter]
: Created DatabaseUser: [SQLLogin 3010 T Zeus Application] from Legin [SQLLogin 3010 T Zeus Application]

DefaultSchema: [dbo] set for DatabaseUser [SQLLogin_3010 T Zeus Applicaticn]
Added [SQLLogin 3010 T Zeus Application] as member of DatabaseRole [RoleApplication]

Example Output
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8 App Objects

Required Authorisation
App Objects (*) Application -> App Objects

(*) You will only see the Applications you are authorised for. Deploying App Objects in different
environments depend on your Request/Approve/Auto-Approval rights for specific Application.

Recommended documentation
Doc-Tab Title Section
Application | App Objects

Pre-requests Menu

Environments and Default Instances Application -> Organisations Applications
DatabaseAlias Application -> DatabaseAlias

Template Database Admin -> Template -> Database
Template Database Role Admin -> Template -> Database Role
Template Login Admin -> Template -> Login

It is important that the content of the QGrip CMDB is up-to-date. Make sure that Discover has run
recently on the Instances of the application and that all objects have been linked properly.

The AppObject windows might at first be intimidating and seem illogical. It is a different way of
working, but once you get used to it, you will see that they are very efficient and will save a lot of
time for standard objects.

8.1 Explorer / Navigate

' Q) Application Objects - 0O X

+ /782G &
AppODrects | U :
ogns (Create 2021-01-22)
5 I Apphcatons I‘
pa t Logns |
L Create 2021-01- ~
. Completed Action F::nn Status ﬂ;y
=% Cancelled pzio
©- [ Dotebese (Create202101-22) Type [Cogns Status Date 101-22093139
@ &4 Logins (Create 2021-01-22) Appication [Messy
“
- Enviconment  Domain | LoginName | HostType
» Acceptance AD SQL_MA_A_Messy-App_SvcUser Instance v

Nw | Es | Cose |

In the Explorer, sets with status Busy are located directly under the Application. There is also a “Busy
Sets” container at the highest level so they can easily be found.

When a Set is Completed or Cancelled, it is moved to the Completed / Cancelled container.

If a deployment is Skipped in all Environments, the Set is still regarded as Completed.

8.2 Global steps
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Whenever creating an App Objects set, stick to the following steps.

1. Create the App Objects set

2. Complete editing in all available Environment tabs

3. Check the parameters in all Environments tabs (again)

4. Start deploying in the right order: D->T->A->P
Once you have pressed [Add2Queue] or [Skip Env] in one Environment, the complete set will not be
editable anymore.

8.3 New Set

When you (try to) create a new set, you might run into one of the following situations.

Set Type Situation Reason

Create Database Error Message You need to Define

Create Logins No (DTAP) environments have Environments/Default DBHost for
been defined for this application. | the Application.

Create Database without | Error Message: Database Aliases need to be

Database Alias Selection Incomplete added for the Application.

Drop (All types) Edit window is Empty. There are no objects to drop.

8.4 Deployment Status

The Deployment section of an Environment tab looks like this.

~Deployment
- Default Database Host | Change ID |
Domain [GOS8 Deployment Status | New =l sdpEnv
Instance [BTSTSQLIS\TST Croots Afler [2024-0415 1552 > Add2Queve |

Depending on the Deployment status, different Action/Info buttons will be available.

Deployment Status Description Action / Info Buttons
New No deployment has taken place. Add2Queue, Skip Env
Queued Deployment is on the Queue, waiting to be picked up. Refresh

Completed Deployment has successfully taken place. ViewlLog

Failed Deployment failed. ViewlLog

Awaiting Approval | Deployment is waiting for approval. Refresh

Request Denied Approval was Denied. View Reason

Insufficient Rights You do not have sufficient right to push Deployment for Explain
the current Environment on Queue.

Cancelled The whole App Objects set has been cancelled. None

Skipped Deployment in current Environment has been skipped. None

Depending on your configuration, you might need to add a ChangelD when you push a request on
the Queue using the Add2Queue button.

8.5 Cancel Set

As long an App Objects set has not been deployed (or Skipped) in one environment, the whole set
can be cancelled. Open the Set with edit and press the Cancel-Set button.

29



If the App Objects set has been deployed or skipped in one or more Environments, you need to press
the Skip Env button in the remaining Environments.

8.6 Create Databases

8.6.1 The Create Databases window

) Edit: Create Databases 5. 4. - (m] X
|MSY-Messy ~] ™ Deployment Details ™ Hide Templates I
Template Databases | Cancel Set |

 Envronments

E

| coiel> | TstAccPrd ba)-sussa NAME(1) pmodu| AUTO_UPDATE_S
Smal-NoMkas | {AppKey)_(E) Tat Acc.Prd | jsa}+SUSER_NAME(1) | [nstance Defaut] | AUTO_UPDATE._S

»

'Smd ) Core TI.Acc ) [hamoo[)dall AUTO UPDATE_STATISTKLSAUTO CREATE_STATISTICS
» Small (1) Segng | ToAcc " TO UPDATE : prp—
Test Imlml =
Smd(l) MSY T Core |Core [8a]=SUSER_NAME(1) Serple 10MB/10MB/1.000MB | 10MB./10MB/1.004
» Smd(l) MSY_T_Stagng | gty [sa]=SUSER_NAME(1) 'Semple 10MB/10MB/1.000MB | 10MB/10MB/1.00{
«| | »

The Create Database window:

1. The Template Databases that can be used to create new databases

2. The Databases with setting that should be the same in all DTAP environments

3. One tab per DTAP environment with the actual physical Databases

4. Once the Databases have been generated from the Templates, they can be hidden for more
room on the Window.

5. Check Deployment Details when ready with specification and start with rollout.

Templste | DBAliss | Envionments | Collation |Dad>a00uiom

Edit

Parameters that should be the same in all DTAP environments such as Collation and/or Database
options.

Delete

If you delete a record here, the related records (databases) will be deleted in each DTAP
environment.
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Small (1) MSY_A_Stagng | Stagng [ Dadete ul 100MB/100MB/10.000MB | 100MB/100M§
«| | »
Edit
Just Edit the selected records in the DTAP environment tab.
Delete

Just delete the records in the DTAP environment tab.

8.6.2 Create Databases

Click on the New button

New AppObject Set Selection
P Myiops [T |
Set Action lctede v
Object Type IDdabase v

OK I Cancel I

Select Application, Create, Database.

TumluoDudmu'

Template * NamngConventon | Envionments | DatabaseOwner | Collation | DatabaseOptic
Smal (AppKey)_{E)_{Databaselias) |Tst A '
Smal-<Replace> | fppKey)_(E)_Replacel> | Tat Ao f':"w"mm
SmakNoMas | Popkey)_(E) TafocPd  |ball—— <! B
Test » Al G-
Acceptance » Core
Production » Root
: Staging
From the Template Small, Add for All environments, for All Aliases.
Databases |
Envionments | Collation DatabaseOptions
Tst.Acc.Prd (instance Default] | AUTO_UPDATE_STATISTICS AUTO_CREATE_STATISTICS
Tt Acc.Prd [instance Default] | AUTO_UPDATE_STATISTICS AUTO_CREATE_STATISTICS
Tst Acc.Prd | Instance Default] | AUTO_UPDATE_STATISTICS AUTO_CREATE_STATISTICS

For each Database Alias, a Database record has been created for Tst, Acc and Prd.
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Owner

Data

Log

[sa]=SUSER_NAME(1)

10MB/10MB/1.000MB

10MB/10MB/1.000MB

[sa]=SUSER_NAME(1)

10MB/10MB/1.000MB

10MB/10MB/1.000M8 |

[sa]=SUSER_NAME(1)

10MB/10MB/1.000MB

10MB/10MB/1.000MB

Data

100MB/100MB/10.000MB
100MB/100MB/10.000MB
100MB/100MB/10.000MB

Log

100MB/100MB/10.000MB
100MB/100MB/10.000MB
100MB/100MB/10.000MB

Owner

[sa]=SUSER_NAME(1)
[sa]=SUSER_NAME(1)
[sa]=SUSER_NAME(1)

Log
100MB/1.000MB/10.000MB

100MB/1.000MB/10.000MB
100MB/1.000MB/10.000MB

Data

100MB/1.000MB/10.000MB
100MB/1.000MB/10.000MB
100MB/1.000MB/10.000MB

Owner

[sa]=SUSER_NAME(1)
[sa)=SUSER_NAME(1)
[sa]*SUSER_NAME(1)

In Production, 3 databases will be created.

) £da: Create Databases

1.

Aoph Save I
’Vpn. ] ¥ Deploymert Details [™ e Templones I
[ Trcommce | Prodcon] 4 2., comcase |

-

Close
Defsult Database Host Change © I _ G|
Oomen [G056 Degioyment Stang [N =] sipE |
teataece [ETSTSGLZZ ST -
Creste Afier [202¢0415 1846 _ll 2dd2Quece I 3.

Terpiste | Database DBMss | Owner |Recovey  Daa Log Colstion :I
» Poss_T Core | Core [ss]eSUSER_NAME(1) Segie 10MB/10MB/1 000MB | 10MB/10MB/1.000MB  [atance Defaut]

Smal()  |Pota_T_Roct |Rect | aJeSUSER_NAME() Semgie 10MB/10ME/1 000MB | 10ME/10MB/1 000MB | [rstance Defat] | AL

Smal()  |Posa_T_Sagng |Sagng | jssleSUSER_NAME() Seple 10MB/10ME/1.000MB | 10MB/10MB/1 000MB | [natance Defaut] | AL
< | B

1. Check the Deployment Details to enable rollout.
2. For each DTAP Environment
3. Add2Queue

¥hen an Applbjlect Set has been Deployed or Skipped
in one environment, the whole set becomes read-only
and cannot be edited anymore.

Do you want to continue?

[ox ] _come |

When pushing Add2Queue in the first environment a warning is issued.
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8.7 Create Logins (and Database Users)

Create Logins is really a combination of Logins, Database Users and their Database Roles.

Instance level

The Login will only be created if it does not already exist.

When creating a new SQL Login an entry will be added to the Password Safe.
Server Roles will only be added to the Login, never removed.

Database level

The Database User will only be created if it does not already exist.

Database Roles will only be added to the Database User, never removed.
Permissions for Database Roles with source Template will be completely updated.

8.7.1 The Create Logins window

©) Edit: Create Logins 3. - 0o X
[Portia =] I Deployment Details ‘ . I
Terciate Logns | Cancel Set |

S|U/G|Templte |sOL | ADUser | ADGrowp | Close |
v EIP [ xouser  [Uookey)_(€)_sopuser | Doman)\Upokey)_(E)_tppUser | {Doman) GS5_UippKey)_{E)_AopUser | Roleoo

I™ |7 | | Engneectiser [N/ 4, | (Doman)\Uookey)_(E)_Upohame) Engneerise | Doman) GSG. UopKey)_(E)_Upphame)_Engnesrer Ence

[P [svetser A " | (Doman)\UtppKey)_(E)_(sooName)_Sweliser | WA SvcUser

T ¥

Test | Acceptance | Production |

AccourtType | D Mes | LognT, | Logr | o R | Serverfoles | Ststus | StatusDatetime
» Core ' | Poria_T_AopUser | RoleAopUser [Mew 202404151922 |
|AopUser (1) | Roat '2' |Portia_T_ropUser |RoiedopUser | New | 202604151922 |
T |aeplser() | Sogng saL | Podia_T_rppUser | RoieAppUser New  |202404151922 |

The Create Logins window:

1. The Template Logins that can be used to create new Logins/Database Users

2. One tab per DTAP environment with the Logins/Database Users

3. Check Deployment Details when ready with specification and start with rollout.

[Test | Acceptance | Production | <

| LoginName
e PpUser | RoleApp User
ppUser | RoleAppUser 2024-04-1519:22
ppUser | RoleAppUser New 2024-04-15 19:22

LoginName

DatabaceRol

ServerRoles

Edit — LoginName

Edit — DatabaseRoles

Edit — Server Roles

Delete - Selected Records

8.7.2 Create Logins

Click on the New button
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New AppObject Set Selection

W MyZees  |Potia =l
Object Type |Logns >l
ok | coma |

Select Application, Create, Logins.

Template Logns |

<t AN

Login Type

P |SvcUser  NA ~A * Y)_{E)_(opName) SvcUser | N/A

ADGroup »

ADUser >

SQL » Environment
*-All » Aliases
Test > Al d—
Acceptance » Core
Production > Root

Staging

From the Template AppUser, Add Login Type SQL in All environments, for All Aliases.

| AccountType | Databasedliss | LognType | LoginName | DatabaseRoles | ServerRoles  atus | SatusDatetme
O - saL Potta_T_foplser Roleiopliser | New 202404151345
PopUser (1) Root saL Portia_T_AppUser | Role AppUser New 20240415 19.45
AppUser (1) Stagng saL Portia_T_AppUser | Role AppUser New 20240415 19.45
In Test, 3 Logins/Database Users will be created.
N o e
_ AccountType | DatabaseMlas | LognType | LognName | DatabaseRoles | ServerRoles | Satus | QatusDatetme
» O sl Potia_A_Avp\Waer | Role/op User New | 202404151945
PopUser (1) | Root saL | Portia_A_AopUiser | RoleAppUser | New 2024-04-15 19:45
AopUser (1) | Stagig saL Portia_A_AppUlser | RoleppUser New 20240415 19.45
In Acceptance, 3 Logins/Database Users will be created.
Sl ==
| LognType \ugnum DatabaseRoles | ServerRoles | Status | StatusDatetime
SaL Portia_P_AppUser | RoieAppUser New 202404151945
|saL Portia_P_AppUser | RoleAppUser New  |2024041519:45
saL Portia_P_AppUser | RoleAppUser New 2024-04-15 19:45

In Production, 3 Logins/Database Users will be created.
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) £dit: Create Loging

|Portis

[~ Defsult Database Host

B8

7] ¥ Degloymeet Detsils

lr- .]wlml — 2.

Domsin  [5058

lestance [BTSTSGLZZ\TST

1 Change IO |

| Creste ster | 20240415 19.45 ;jl Add2Queve |3.

Pl :

Degloyment Satus | New =] supEnw I

» T
[lcpu.cu) | Roct
| AppUser (1) Stagng

| AccountType | DatabaseMiss | LognType | L

DatabaseRos SeverR |t | StuaDtetme

saL Posia_T_fopUser | RoleopUser | [New | 202408151545
Isat |Poia_T_rppUser | RoleopUser | [New 202608151345
Isat |Potis_T_topUser RolesoplUser | [New | 202604151345
| »

1. Check the Deployment Details to enable rollout.

g

3. Add2Queue

Warning

For each DTAP Environment

¥hen an Applhject Set has been Deployed or Skipped

in one environment, the whole set becomes read-only
and cannot be edited anymore

OO0 you want to

continue?

[ox ]_coxa |

When pushing Add2Queue in the first environment a warning is issued.

8.7.3 Verify AD accounts

The first time (in the first Environment) a Deployment is initiated for a Create Logins set, using either
[Skip Env] or [Add2Queue], a check will be performed to verify that used AD-Users and AD-Groups
exist on AD. If this check fails, you will receive a message with an overview of accounts missing on
AD. As long as the Accounts are part of the set and not exist on AD, deployment will not be possible.

8.7.4 Edit Environment tab-page rows

After adding Logins from the Template Logins, you can edit/delete rows in the Environment(s) tab-
page by selecting the row(s) and right-click to open the Context Menu:

Test |Acceptance | Production |

AccountType / | DatabaseAlias | LoginType | Loginh

Edit »
ETLUser Delate
FATesters a1 A—
FATeaters PushvStanine

LoginName
DatabaseRoles
ServerRoles
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In the Apply To sections of the Edit window, you need to specify which occurrences should be
updated. The “All” wildcard enables you to update multiple occurrences in one go.

~Apply To
Account Type  |Application ~|
Login Type >
Database Alias [Al ~|
Environment (Al |

In the selection above, all occurrences with Account TYpe Application and Login Type SQL will be
affected.

8.7.5 Edit: Login Name

Login Name
ISQLLogin_ _Non_Standard_Name

When changing the Login Name, you are likely to deviate from the standard naming convention.

8.7.6 Edit: Database Roles

Best is to stick to the Database Role defined together with the Template login but if needed, this
option enables you to grant (other) database roles.

Databsse Roles

<

RoleName | Source  DBPermissions | SubRoles

RoleApokc atior
RoleApphcat

™ db_datareader  Foxed \
| b _dotawnter  |Fued \
| r :cb_ddadm'n Foxed [
| T dv_owner |Foed [ [
| ™ RoleApplicaton2 Exising  ALTER DELETEEXECUTE.INSERT.REFERENCES SELECT.UPDATE | \
| [ |RoleETLUser  Tempiste SelectinsenDelete.Update Execute Aer | db_ddiadmin \
| [ RoleFATester  Template Execute | db_datareader.db_datawriter |

| [ RoleMaintUser  Tempiste SelectinsedDelete.Update I

I RoleUATester |Template Select \

The DB Permissions column shows the permissions the role has on database level.

Source Description

Template Template database roles defined by the QGrip-Admin.
Fixed SQL Server standard database roles.
Existing Database role already exists in the database(s)

It is possible that a Role Name is listed twice, once with source Template and once with source
Existing. In that case you will only be able to choose one of the occurrences.

Template vs Existing
Source Deployment rules



Template If the Database Roles already exists in the database, its permissions will be
replaced with the “new” permissions during deployment.
Existing The permissions of the database role will NOT be changed.

Existing and Database Alias / Environment All

When you grant an Existing role in combination with Database Alias and/or Environment All, the
Database Role must already exist in all databases affected by the combination. This check will be
performed before any records are updated.

8.7.7 Edit: Server Roles

You can also add server roles to the login. Only “bulkadmin” is available at this moment.

8.8 Drop Databases

Click on the New button

Select Application, Drop and Database.

In each Environment tab-page, mark the databases you want to drop by checking the Drop column

and pay attention to the Instance name so that you do not drop the database on the wrong Instance.

Before starting deployment, consider making an Archive backup of the databases you are about to

drop.

8.9 Drop Logins (and/or Database Users)

Click on the New button
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New AppObject Set Selection

W Mylops |Poria ~
Set Action lw El
Object Type |Logns ~|

ok | coms |

Select Application, Drop and Logins
In each Environment tab-page, there are is one section for Logins and one for Database Users. Mark
the Logins and Database Users you want to drop by checking the Drop column and pay attention to

the Instance and Database name so that you drop the right occurrence.

Dropping a Login, the corresponding database users will NOT automatically be dropped. You will
need to mark the corresponding Database Users for Drop as well to avoid orphan Database Users.

If a Database User owns objects in the database, the drop will fail. Exception is an empty Schema,

that will automatically be dropped as well. If the database has been designed properly, a Database
User will not own objects.

8.10 Drop Roles + Members

Click on the New button

New AppObject Set Selection

M Mylfops  |Potia =]
SetAction | Drop v
Object Type | Roles+Members =l

ok | coma |

Select Application, Drop and Roles + Members |

In each Environment tab-page, there are is one section for Database Roles, Database Role Members
and Server Role Members.

Mark what you want to drop by checking the Drop column and pay attention to the
Instance/Listener and Database name so that you drop the right occurrence.

Drop Type Description

Database Role The database role will be dropped after its members have been
removed.

Database Role Members | The member will be removed from the Database Role.

Server Role Members The member will be removed from the Server Role.
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9 Connect-Info

Required Authorisation
Passwords (*) Application -> Connect Info

(*) Uses the same authorisation as passwords. You will only see the Applications and Environments
you are authorised for.

Recommended documentation
Doc-Tab Title Section
Application | Password Safe & Connect Info | Connect Info

The Connect Info uses the content of the Password safe. The Connect Info can be used to share
connect parameters with colleagues and supplier.

H €) Connect Info - a X

o I
MyApps  |MSY-Messy o
Envircoment [Tox S

Comnect o | _ Close |

Connect Information
Application : MSY-Messy
Environment :@ Test

Led Lo

Instance : ADEVSQL12\TST
IP Address : 10.10.20.51
PortNumber : 1440

Domain : GOS-A.intra

Version : 2012

Connect : ADEVSQL12\TST
ADEVSQL12\TST, 1440
ADEVSQL12, 1440
ADEVSQL12:1440

Databases

- MSY_T_Core

- MSY_T_Staging

Logins
= Login : GOS-A\GSG_MSY T Messy EngineerUser
- Database : MSY T _Core, MSY T_Staging

- Login : SQL_MSY T Messy_ AppUser
~ Password : B8<234!5i62Ns
- Database : MSY T Core MSY T Staging

M

Select Application and Environment and Press ‘Get Info’. AD logins will also be included.
If a password is not valid, you will receive a warning but the information will still be provided
(without the missing password).
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10 Password Safe

Required Authorisation \ Menu
Passwords (*) Application -> Password Safe
(*) You will only see the Applications and Environments you are authorised for.

Recommended documentation
Doc-Tab Title
Application | Password Safe & Connect Info

QGrip comes with a Password Safe that will contain entries for all Logins with SQL Server
authentication, from now on referred to as Account. When an Account is created via QGrip
AppObjects or in a PostClone script, a Password will be generated and the Password Safe will
automatically be updated.

Verify Password

If the Discover process finds an Account on an Instance that is not already in the Password Safe, it
will be added with status “Not in Safe”. If you have the password elsewhere, you can add it to the
Password Safe and request a Verify password. One of the QGrip Server worker processes will try to
login on the Instance using the Password you entered. If login attempt is successful, the Password
Safe is updated and the Password status is set to OK. If it fails, the Password status is set to “Safe <>
Instance” and you have to wait for 1 hour until you can try again with a different password. This
delay is to prevent hacking and that Accounts are being locked out.

Password Status  [Safe <> Instance Enforce Password Policy IOFF

Last Verify 2015.10.16 113048 | Verify Password Enabled

Password Status in Safe
OK Password Safe = Password on Instance

Not in Safe The password is missing (empty) in the Password Safe

Safe <> Instance Password Safe <> Password on Instance

Not on Instance The Account is in the Safe but no longer exists on the Instance. This should
never happen.
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If there are inconsistent/incomplete passwords, separate entries are shown in the Explorer so that
they can be found easily. These special containers will stay until you reopen the window. The
Password with “not OK” status can also be found under the Application.

10.1 Edit Passwords

Open the Account with Edit. In the tab-page Account, see the following section:
| Password : SQL_MSY_A_Messy_AppUser ‘

P SQL_MSY_A_Messy_AopUser

Account | Passwordlog | Satuslog |

Application |MSY-Messy

Instance JADEVSQLIZ\ACC

PasswordStatus [OK  Enforce Password Policy [ON
Last Verify [20210710055530  Verify Password Enabled [No

AccountName  [SQL_MSY_A_Messy_AopUser

P f Show | Copy I
¥ Monitor Password and g \Warning

~Pa 4 Actions

Using |New Password =l

New Password |

Scope Change [Safevinstance ~] ooy |

AddedBy  [GOS-A\DEV_gMSA_ OGS At 120210626 16:50:34
ModifiedBy [GOS-A\DEV_gMSA_QGrp$ A [202107-100559.36

What you can do in Password Actions depend on current Password Status and if Verify Password is
Enabled. If no actions are possible, Password Actions will be disabled. Otherwise, only valid choices
will be present.

Using (Password)
Using (Password) Description
Existing Password Use password in Safe, only possible when there is a password.
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Generated Password A password of specified length will be randomly generated and used.
New Password Enter the password manually.

Scope change

Scope Description

Verify Push a Verify Password job on the Queue to see if password is correct.

Safe Save password to Password Safe

Safe + Verify Save to Safe + Verify Password

Safe + Instance Save the password to the Password Safe and change it on the Instance.
This will only be possible if the Password Status is OK.

When you press Apply you need to confirm the action. If the scope includes Verify or Instance, you
will receive a Personal message when the action has taken place.

The content of the tab-pages is refreshed when switching from another tab-page.
Important

When you change the password on an Instance, all clients using that account will need to change
their connection string. Handle with care!

10.2 Monitor Password and generate Warnings

Password Monitoring

The password will no longer be monitored
0 and no Warnings will be generated.

Password Monitoring

0 The password will be monitored.

By default, QGrip will monitor the Password to make sure that it has the correct password and issue
Warnings if that is not the case. Is monitoring of the Password is not wanted of a certain login,
uncheck the ‘Monitor Password’ check box for the login.

To reactive, check the ‘Monitor Password’ check box again and the monitoring will restart.

10.3 Delete Accounts/Passwords

Accounts/Passwords can only be deleted when the current tab-page is ‘Not on Instance’.
10.4 Password Log + Status Log

In Edit mode, the tab-pages PasswordLog and StatusLog will be present next to the Account tab-
page.

PasswordLog
Shows all Password Actions initiated by a user, including former passwords.
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StatusLog
Shows a history of Password Status.
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